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. 
Trademarks
SVSi is a trademark of Southern Vision Systems, Inc. in the United States and other 
countries. All other brand names, product names, and trademarks are the property of their 
respective owners. Certain trademarks, registered trademarks, and trade names may be 
used to refer to the entities claiming the marks and names (or their products). SVSi disclaims 
any interest in the marks and names of others.

To the Reader
The contents of this manual are current as of the date of publication. SVSi reserves the right 
to change the contents without prior notice (including URL and other Internet Web site 
references).

While every effort has been made to ensure that the information contained in these 
instructions is accurate and complete:

• No liability can be accepted for any errors or omissions. 
• SVSi reserves the right to change the specifications of the hardware and software 

described herein at any time without prior notice. 
• In no event will SVSi be liable for any special, incidental, or consequential damages or for 

commercial losses (even if SVSi has been advised thereof) that result from issue or use 
of this publication. This includes damages resulting from corrupted or lost data due to 
mistaken operation or malfunction of the hardware, software, or accessories.

 

360B Quality Circle NW Suite 200
Huntsville, AL 35806
Phone: 256.461.7143

Fax: 256.461.7145
Email: info@svsiav.com

Website: svsiav.com
Support: support.svsiav.com

All Rights Reserved.

Printed in U.S.A.
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. 
Safety Instructions
Please read the safety precautions carefully before using this product. Ensure that you use 
the product correctly according to the procedures described in these instructions. 

The following safety precautions are intended to instruct you in the safe and correct operation 
of the product and its accessories to prevent injuries or damage to yourself, other persons, 
and property. Please read and ensure that you understand them before you proceed to the 
other sections of these instructions.

• Do not operate this device in a wet environment.
• Refer servicing to qualified service personnel only.
• Please read the User Manual and other provided documentation carefully before operat-

ing. Follow all operating and other instructions carefully.
• Do not use this product near heat sources such as radiators, air ducts, areas subject to 

direct, intense sunlight, or other products that produce heat.

Caution: Changes or modifications to this unit not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment.
Page ii N8300 Controller User Manual www.svsiav.com  



. 
FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation. The Class A limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference, in which case 
the user will be required to correct the interference at his own expense.

To comply with FCC and Industry Canada RF exposure limits this device must be 
installed to provide a separation distance of at least 20 cm from all persons and must 
not be co-located or operating in conjunction with any other antenna or transmitter.

Service and Warranty
For information on the service and warranty of SVSi products please visit our website at 
www.svsiav.com.

Caution: These units contain no user-serviceable parts. They should only be serviced by 
qualified service personnel.
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C H A P T E R  1 Introduction
Introducing Your New N8300 N-Touch Controller
Product Overview
SVSi’s N-Touch N8300 Series Wall Controller is a stand-alone, dual-gang, IP controller that 
sends commands to multiple IP clients with the push of a button. The N8300 has eight 
programmable tactile buttons with a 240 x 320 pixel display. Programming is done individually 
through the built-in web-server or collectively to multiple units using an N-Command N8000 
Series controller. Multi-page custom controller panels can be created using SVSi’s free Panel 
Builder software (stored internally) and then launched at start-up or at the push of a button. 
The N8302 comes with a capacitive touch display and built-in WiFi and Bluetooth beacon for 
expanding control to mobile devices.

The N8300 can connect to and control any Ethernet-controllable device by simply sending 
commands to an Encoder/Decoder which then sends an RS232 or IR command to the device 
you wish to control.

SVSi’s non-proprietary controllers offer a low-cost option for customers to have secure 
access to devices on their network, such as teleconferencing CODECs, lighting, and sound 
systems. Unlike wireless controllers, the N-Touch is still in command even when wireless 
access is compromised. The Controller supports both U.S. and European wiring standards.

Figure 1-1. N8300 Series Front Panel
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Chapter 1. Introduction Product Highlights
Product Highlights
• One controller for all devices
• Low cost of installation
• Low-voltage cable
• Multiple commands sent to multiple TCP/IP clients
• Robust Power over Ethernet (PoE) reliability and redundancy

Specifications

Display  3.5”, 240x320 pixel screen (N8302 has a touch-screen).

Buttons Eight user-defined tactile buttons. Each button can be defined differently for 
each panel (allowing for an unlimited number of functions to be button-
controllable). N8302 also has unlimited user-defined soft buttons (which can 
be defined differently for each panel).

Power and Data 
Connection

8-wire RJ45 female Power over Ethernet (PoE)/100Base-T connector provides 
both the network connection and the power to the N-Touch Wall Controller. 
Units must be powered via a PoE switch or other equipment with a PoE 
source. Conforms to IEEE 802.3af Class 3 (802.3at Type 1).

PoE Consumption 2.5W

Command Protocols TCP or UDP

Graphic Formats GIF, JPG, or PNG

Management Built-in web server, N-Able, and N-Command N8000 Series controller

WiFi (N8302 only) Internal 2.4Ghz 802.11g wireless access point (optionally bridged to the wired 
connection).
Max Transmit Power: 14.5 dBm, 54 Mbps OFDM (g) 
Max Receive Sensitivity: -76 dBm, 54 Mbps OFDM (g)

Bluetooth (N8302 only) Bluetooth V4.0 Low Energy (BLE) - Beacon Service only. BLE Beacon is used 
in conjunction with SVSi Mobile App to initiate WiFi connection on device to 
connect and display a Panel Project specified by settings.

Mounting Options Flushmount into the wall or mount into an existing electrical box using adapter 
ring.

Warranty  2 years parts and labor

Environmental Temperature: 32° to 104°F (0° to 40°C)
Humidity: 10% to 90% RH (non-condensing)
Heat Dissipation: Up to ~6 BTU/Hr

Dimensions  4.5” x 4.5” x 1.5” (2-gang)

Weight  0.5 lbs
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C H A P T E R  2 Installation
Installing the N8300 N-Touch Controller
Introduction
This chapter guides you through the installation process of mounting your new N8300 and 
logging in for the first time. 

There are two types of installations available: 

• Flushmount Installation: This version of the N8300 comes equipped with the installation 
box and cut-out template for your wall. See the section Flushmount Installation Instruc-
tions on page 4 for more information.

• Ring Adapter Installation: This version of the N8300 comes equipped with a ring 
adapter which allows you to install the unit into an existing dual-gang electrical box. See 
the section Ring Adapter Installation Instructions on page 5 for more information.

Installation Considerations
• If desired, you can pre-configure the unit before physically installing it. To do so, simply 

plug an active PoE-enabled Ethernet connection into the back of the controller and skip to 
the section Configuring Your New N-Touch Controller on page 6 for further instructions.

• The information given in this chapter assumes the installer needs no instruction on run-
ning Ethernet to the installation box or other basics.

• Ports 80 and 3001 cannot be blocked for the N8300’s IP addresses.
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Chapter 2. Installation Flushmount Installation Instructions
Flushmount Installation Instructions
Follow these steps to flushmount your new N-Touch Wall Controller into the wall.

1. Using the Wall Controller Installation Cut-Out Template (enclosed in shipment), mark 
the position on the wall where the unit is being installed and cut the opening.

2. Once the opening is cut (and the PoE-enabled Ethernet cable is accessible through the 
opening) insert the plastic installation box (included in shipment). Use the break-out tabs 
as needed to correctly position the Ethernet cable.

3. Secure the installation box to the wall with the two captive screws.
4. Connect the Ethernet cable to the rear connector of the N-Touch Wall Controller.
5. Place the N-Touch Wall Controller display into the box and secure it with four screws 

(included in shipment).
6. Complete the installation by snapping the SVSi faceplate onto the front of the N-Touch Wall 

Controller.

Figure 2-1. Flushmount Installation
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Chapter 2. Installation Ring Adapter Installation Instructions
Ring Adapter Installation Instructions
Follow these steps below to mount your new N-Touch Wall Controller into an existing dual 
gang electrical box. The instructions given assume the box is already installed with Ethernet 
access running to it.

1. Secure the mounting ring adapter (included in shipment) to your existing dual gang 
electrical box with four screws.

2. Connect the PoE-enabled Ethernet cable to the rear connector of the N-Touch Wall 
Controller.

3. Place the N-Touch Wall Controller display into the box and secure it with the four screws 
(included in shipment). 

4. Complete the installation by snapping the SVSi faceplate onto the front of the N-Touch Wall 
Controller.

Figure 2-2. Ring Adapter Installation
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Chapter 2. Installation Configuring Your New N-Touch Controller
Configuring Your New N-Touch Controller
In order to access the N-Touch Controller for configuration, the host PC must be in the same 
subnet. N-Touch devices are shipped in Auto-IP mode with a default IP address of 
169.254.xxx.xxx. Before attempting configuration, some changes must be made to the host 
PC. 

Steps for IP Address Configuration (for Windows 8)
1. On the host PC, select Control Panel > Network and Sharing Center from the Start 

menu.
2. Select Change adapter settings.
3. Select the wired interface connected to your AV network.
4. Click the Properties button.
5. Scroll down in the list to the Internet Protocol Version 4 (TCP/IPv4) option. Highlight it 

and click the Properties button.The screen shown below is displayed.
6. Enable the Use the following IP address option, and enter the static IP address 

provided to you by your network administrator.

Figure 2-3. Host PC’s IP Settings
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Chapter 2. Installation Logging in for the First Time
Logging in for the First Time
Once connected to the network, the welcome screen appears on the N8300’s front panel and 
displays the unit’s serial number, MAC address, and IP address. See Figure 2-4.

Figure 2-4. N8300 Initial Screen

1. Using your computer, enter the N8300’s IP address into your web browser. 
2. The N-Series Wall Panel Controller Login screen is displayed (Figure 2-5). Use the 

following default login credentials (admin and password) to log in for the first time.

Figure 2-5. Login Screen

Serial #: N832A010000756

IP Number: 169.254.9.67

MAC Addr: 00:19:08:01:43:07

To set up this unit go to 
the unit’s configuration 

page:

http://169.254.9.67

Enter the unit’s IP address 
into the web browser of 
your host computer.
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Chapter 2. Installation Logging in for the First Time
3. Upon successful login, the Settings page is displayed (see Figure 2-6).

Figure 2-6. Settings Page

See the chapter Option Descriptions on page 9 for field-by-field descriptions of the N8300 
interface’s pages and selections.

For added security, 
change the password.
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C H A P T E R  3 Option Descriptions
Understanding and Navigating the N8300 Controller Interface
Introduction
The interface of the N8300 is divided into six main pages:

• Settings (described in detail beginning on page 10)
• Wireless (described on page 13)
• Logs (described on page 15)
• LLDP (described on page 15)
• Users (described on page 16)
• Panel Builder (described in detail beginning on page 17)

You can access the main pages by clicking on the links available at the top-left of any screen 
(see Figure 3-1). 

Figure 3-1. Accessing the Main Pages

Note: The Panel Builder opens in a new webpage, therefore whichever page you launch 
it from remains accessible on a separate tab of your browser.

Access the six main pages 
using these links.
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Chapter 3. Option Descriptions Settings Page
Settings Page
The first screen to display after you log in is the Settings page (shown in Figure 3-2). Here 
you can perform important unit setup operations such as:

• Changing the device’s name and home screen.
• Performing an operating system reboot.
• Configuring network settings.
• Changing your password.

Figure 3-2. Setting Page

Note: If you need instructions on logging in to the unit, refer back to the Logging in for the 
First Time on page 7 of Chapter 2.
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Chapter 3. Option Descriptions Settings Page
Refer to Table 3-1 for detailed descriptions of the options available on the Settings page.

 Table 3-1. Settings Page Option Descriptions

Option Description

Settings

Device Name Change the name to something meaningful and more user-friendly so that it may be 
easily referenced. By default, the unit is named by its MAC address.

Panel Project Once you have created panels in the Panel Editor, you can choose one from this list 
to be the panel’s home page. See the section Panel Builder on page 17 for more 
information.

Home page Enter the URL for the screen you would like displayed as the home page on the 
N-Touch Wall Controller screen. The URL automatically populates when you select a 
saved panel from the Panel Project drop-down menu (see above).

Brightness Adjust the backlight of the N-Touch Controller’s active panel screen. (The screen dims 
automatically during sleep mode.)

Dimness Adjust how dim the backlight will be when the N-Touch Controller panel screen goes 
into sleep mode.

Sleep Delay Sec Enter time (in seconds) until the N-Touch Controller’s panel screen goes into sleep 
mode when idle. Enter 0 for never.

Discovery Packet 
Transmit

Enable to send out multi-cast packets so the N-Touch Controller can be discovered.

Discovery Interval 
(sec)

Enter an interval (in seconds) to lapse in between transmission of the multi-cast 
packets.

Cancel/Save buttons Cancel or save any changes made in the Settings section of this page. When making 
changes to device Settings, no changes will occur until this Save button has been 
clicked. One or more changes can be made at the same time. 
Note: This Cancel/Save choice does not apply to the other areas of the Settings 
page (Network Setup, Change Password, etc.).

Software

Serial View the unit’s serial number is displayed here.

Mac Address View the MAC address of the unit’s network interface is displayed here.

Web Version View the date code for the currently running version of the web interface is displayed 
here.

Firmware Version View the date code for the currently running version of the internal firmware is 
displayed here.

Factory Restore 
button

Click to restore the unit to its factory default settings.

Reboot button Click to power the unit down and back up, keeping the current settings intact
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Chapter 3. Option Descriptions Settings Page
Network Setup

IP Mode Select the IP mode from the drop-down menu. The options are AUTO IP, DHCP, and 
STATIC. For most applications, a STATIC IP address is recommended.

IP Address View the current IP address. When in STATIC mode, you can enter a new IP address 
here. All IP addresses must be unique. Two or more devices set to the same IP 
address will cause problems with the SVSi system and controls. This includes third-
party IP devices as well.

Netmask View the current subnet mask. When in STATIC mode, a new subnet mask can be 
entered here.

Gateway Address View the current gateway address. When in STATIC mode, you can enter a new 
gateway address here. A gateway address is required even if a gateway is not 
present in the project. If this is the case, enter an IP address such as 169.254.1.1 (or 
a value that works with the desired IP scheme).

IP Address 2 Check this box to enable a second IP address for the unit.

IP Address View the unit’s second IP address. When in STATIC mode, you can enter a new IP 
address here. All IP addresses must be unique. Two or more devices set to the same 
IP address will cause problems with the SVSi system and controls. This includes third-
party IP devices as well.

Netmask View the current subnet mask (for IP Address 2). When in STATIC mode, you can 
enter a new subnet mask here.

Manual DNS Enable if you would like to manually assign your DNS (domain name system) server 
address(es).

DNS address (1-3) Enter up to three DNS server addresses.

Save IP Settings 
button

Save the IP settings. This causes the device to change the IP address and apply all 
other changes made. Now change your web browser to the new IP address. Log in 
and confirm the new IP address. If the IP address is not confirmed, it will revert back 
to the previous IP address the next time the device is rebooted.

Note: IP settings should be configured by a networking specialist and should be set so that the N-Touch 
Controller shares the same network as the controlled units.

Change Password

Click the Change Password link to change the password from its default setting (of password) and increase 
system security. Once you have entered a unique password and confirmed it, click the Change PW button to 
accept the settings. 

 Table 3-1. Settings Page Option Descriptions (Continued)

Option Description
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Chapter 3. Option Descriptions Wireless Page (applies to N8302 units only)
Wireless Page (applies to N8302 units only)
The Wireless page allows you to set up the N8302 to be accessible through the wireless network. 

Figure 3-3. Wireless Page

Refer to Table 3-2 for detailed descriptions of the options available on the Wireless page.

 Table 3-2. Wireless Page Option Descriptions

Option Description

WiFi MAC Address View the unit’s WiFi MAC address.

Enable WiFi AP Enable to allow wireless access to the N8302.

Enable WiFi/Eth 
Bridge

Enable to allow users (connected to the wireless network through the N8302) to 
access the rest of the network. 

WiFi Country Choose your location from the drop-down menu to correctly manage regional power 
regulations.

WiFi AP’s own IP 
address

View the wireless Access Point’s IP address.

Wireless Mode View the current wireless network mode.
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Chapter 3. Option Descriptions Wireless Page (applies to N8302 units only)
Channel Select the wireless channel you plan to use (or choose Auto).

Security Mode Choose Open Access for no password protection. Choose WPA1 or WPA2 to 
configure the unit for WiFi Protected Access security. Ask your network administrator 
if you are unsure which protocol to select.

SSID Enter a Service Set Identifier to distinguish the N8302 on the wireless network. If you 
have multiple units on your network, it is helpful to use descriptive names (e.g., room 
name or number where device is located).

Password Enter a wireless access password for this unit (must be at least eight characters).

Enable Bluetooth 
Beacon*

Enable to activate a bluetooth signal from the N8302 (allowing SVSi’s mobile app to 
automatically detect your N8302 device).
*Future feature.

 Table 3-2. Wireless Page Option Descriptions (Continued)

Option Description
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Chapter 3. Option Descriptions Logs Page
Logs Page
The Logs Page displays a command log which lists all of the TCP/IP messages that the unit 
receives. It also displays the unit’s IP address and gives you options to Refresh and Reset 
Logs.

Figure 3-4. Logs Page

LLDP Page
The LLDP Page displays information from the LLDP (link layer discover protocol) packet 
which identifies the port number and switch that the device is connected to. 

Figure 3-5. LLDP Page
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Chapter 3. Option Descriptions Users Page
Users Page
The Users page allows you to set up mobile panel access. Follow these instructions to 
access panels from your mobile device.

Viewing Panels on the SVSi Mobile App
Once you have a panel created using Panel Builder, log in to the N8300 using your web 
browser.

1. Click the Users link at the top of the page. The screen in Figure 3-6 is displayed.

Figure 3-6. Users Page

2. Use this page to assign the Panel Project you created to your Username (if needed, 
multiple users/logins can be added using the Add User button).

3. Enable the Auto Redirect checkbox.
4. Download SVSi’s free Conductor Mobile app to your IPhone or Android.
5. Log in to Conductor Mobile using the same Username set in Step 2.
6. The Panel Project assigned to your Username is displayed, allowing you to control the 

N8300 from your phone.

Note: In order for this connection to be successful, your N8300 must be on the WiFi 
network (on the same subnet). 
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Chapter 3. Option Descriptions Panel Builder
Panel Builder
Click the Panel Builder link to create multi-page custom graphics for your N-Touch Controller 
display. Pages are stored internally and then launched at start-up or at the push of a button. 

The screen shown in Figure 3-7 allows you to choose between using the N-Touch Wizard or 
the Full Panel Editor (which gives you more customization options). 

Figure 3-7. Panel Builder Welcome Screen

Choosing between N-Touch Wizard and Full Panel Editor
Consider the following when choosing between N-Touch Wizard and Full Panel Editor 
mode:

• N-Touch Wizard allows full control as well as custom buttons and panels.
• Full Panel Editor allows multi-state buttons, conditional logic, and feedback program-

ming not available in the wizard.
• Panels created using the N-Touch Wizard can be imported into the Full Panel Editor if 

those features are needed at a later date. 

Note: You can choose to begin your project in the N-Touch Wizard and then later bring it 
into the Full Panel Editor to make more detailed changes. 

Note: Full Panel Editor panels cannot be imported into the N-Touch Wizard, but they 
are compatible with SVSi's Panel Builder software on the N8000 Series Controllers.
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Chapter 3. Option Descriptions N-Touch Wizard
N-Touch Wizard
When you first open the N-Touch Wizard, an image of your N-Touch Controller is displayed. 

Figure 3-8. N-Touch Wizard Initial Screen

Refer to Table 3-3 for detailed descriptions of the options available on this screen.

 Table 3-3. N-Touch Wizard Initial Screen Option Descriptions

Option Description

Setup Script Click to modify a script/function that will execute when the project loads. Possible 
uses include setting up variables for other scripts to use and requiring controller 
modules to control specific types of devices.

Help links Click Help to access the following links:
• Click Wizard Help to open a copy of the Wizard Tutorial.
• Click Module Help to open a list of SVSi controllers and modules.
• Click Command Help to open a list of tcp commands used to control SVSi 

products.

- Click to delete the current panel from your project.

+ Click to add another panel to your project. 

(set default) Click to set the current panel as the home screen for the N-Touch Controller.

Open Click to open an existing project in the N-Touch Wizard.

Style Click to alter the style of the current panel. Set the panel's background image, button 
background images, as well as button text size, color, and font. Clicking Reset reloads 
the default images onto the panel. Click OK to accept changes/close the Style pane.
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Chapter 3. Option Descriptions N-Touch Wizard
When you click one of the image’s buttons shown on your N-Touch Wizard screen, you can 
add functions that will then execute when a button is pressed on the N-Touch Controller. Click 
the button to display the properties pane (as shown below). Refer to Table 3-4 for detailed 
descriptions of the options available on this pane.

Figure 3-9. Button Properties Pane

Save Click when you have finished adding panels and commands to your N-Touch project. 
Choose Here’s a link to your project to obtain a hyperlink to your project, or choose 
Set to Wall Controller to assign the project as the N-Touch panel default display.

Send to Editor Click to open the current project in the Full Panel Editor mode. This mode allows for 
the creation of multi-state buttons and conditional logic programming not available in 
the N-Touch Wizard.

Note: For step-by-step panel building instructions using the N-Touch Wizard, refer to the 
Wizard Tutorial (available in the Help menu of the N-Touch Wizard).

 Table 3-3. N-Touch Wizard Initial Screen Option Descriptions (Continued)

Option Description
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Chapter 3. Option Descriptions Full Panel Editor
Full Panel Editor
The Full Panel Editor option of the Panel Builder allows you to easily develop and deploy 
the multi-page custom graphic utility panels that will be used to make device control across 
the network intuitive for all users. 

When you first launch Panel Builder, the screen in Figure 3-10 on page 21 is displayed, 
giving you the option to:

• Create a New panel building project from scratch.
• Open or Import an existing project to further customize it.

 Table 3-4. Properties Pane Option Descriptions

Option Description

Command drop-down 
menu

Choose the script/function that will execute when the button is pressed. Choices 
include:
• tcpclient: Assigns the button to send tcp commands to SVSi devices (e.g., 

Encoders, Decoders, DVRs, N-Command, etc.). Once selected, use the resulting 
drop-down menus and text fields to enter the tcp port and command, and to 
choose the SVSi product which will receive the command. 

• udpclient: Does the same as tcpclient, only using udp commands instead.
• module: Creates a module object that is associated with an SVSi product or other 

device that has built-in control functions.
• goto: Assigns the button to a different panel in the project. In other words, when 

the button is pressed, the display on the N-Touch Controller changes to whatever 
panel has been assigned to that button using this function.

discover button For tcpclient and udpclient, click to find SVSi units on the network. After search is 
complete (after 50 seconds or when you click stop), the SVSi Units drop-down menu 
populates with the units that were discovered. Now when adding a tcpclient or 
udpclient command, you can choose the unit from the list and the system will 
automatically fill in the unit’s IP address for you.

add button Click to add the command to the script. 

Visual Button State 
drop-down menu

Choose to make the buttons displayed on the screen visible or hidden.

Button Text field Enter any text you would like to display on the N-Touch Controller’s screen for that 
button. You can change font size, color, and type by clicking on Style.

For step-by-step instructions using the Full Panel Editor, refer to the N-Touch Panel 
Builder Tutorial (available in the Help menu of the Full Panel Editor).
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Chapter 3. Option Descriptions Full Panel Editor
Figure 3-10. Full Panel Editor Welcome Screen

Once you arrive at the main Full Panel Editor page, the following screen is displayed. See 
the sections referenced in the callouts for descriptions of each area of the Panel Builder 
interface.

Figure 3-11. Full Panel Editor Section References

See the section Top Ribbon 
Option Descriptions on page 22 
for descriptions of the 
interface’s top ribbon of options 
and icons.

See the section Tools Pane Option 
Descriptions on page 29 for descriptions of 
this section of the interface.

See the section Project Pane Option 
Descriptions on page 24 for descriptions of 
this section of the interface.
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Chapter 3. Option Descriptions Full Panel Editor
Top Ribbon Option Descriptions
Refer to Table 3-5 for detailed descriptions of the options available in the top ribbon of the 
Full Panel Editor initial page. Hold the Shift key when selecting multiple buttons/widgets (for 
aligning groups of objects, etc.). 

 Table 3-5. Full Panel Editor Option/Icon Descriptions (Top Ribbon)

Option Description

File Open new and existing projects, save or delete projects, and perform import/export project 
functions.

View Preview the current panel or setup script in a separate browser window.

Window Select Tools Pane to display the left pane of the interface (which allows you to add buttons/
sliders/etc. to your panel). Select Project Pane to display the right pane of the interface (which 
allows you to further edit the panel you are building as well as the overall project, add scripts, 
etc.).

Help Select Editor to view a tutorial for Panel Builder, Modules to view a list of module scripts, Scripts 
to view a user guide for Panel Builder scripting, or Commands to view a list of direct control API 
commands. 

Set border size (in pixels) and border color for the selected button or widget. 

Click to set a border radius of each corner of the selected button or widget.

Create a copy of the selected button or widget.

Use to make all of the buttons have the same size. The first button you select (highlighted in 
green) will be the size that the other selected buttons (highlighted in blue) will conform to when 
this icon is clicked. 

Left-align the selected buttons or widgets to the main selected item. 

Right-align the selected buttons or widgets to the main selected item. 

Top-align the selected buttons or widgets to the main selected item. 

Bottom-align the selected buttons or widgets to the main selected item. 

Center-align the selected buttons or widgets horizontally. 

Center-align the selected buttons or widgets vertically. 

Center-align the selected buttons or widgets horizontally and vertically. 
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Align and evenly distribute the selected buttons or widgets horizontally. 

Align and evenly distribute the selected buttons or widgets vertically. 

Align the selected buttons or widgets to the grid. Allows you to select the number of rows/columns 
and then aligns the selected objects to that grid.

Opens the script editor and allows you to assign/change scripts for the selected button or widget.

Delete the selected button(s) and/or widget(s). 

Zoom in.

Zoom out.

Click/drag to reposition the panel on the screen.

Resize and center the project to fit the current browser window.

Undo previous action.

Redo a previous action that was undone using the undo  function (see above).

Delete a panel from the current project.

Add a panel to the current project.

Scroll through the panels of the current project.

 Table 3-5. Full Panel Editor Option/Icon Descriptions (Top Ribbon) (Continued)

Option Description
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Project Pane Option Descriptions
On the right side of the main screen, you will find options that allow you to edit the current 
panel you are building, your overall project, as well as view your project assets (such as 
available images, created scripts, and related modules). If you do not see this pane displayed 
on the main page of the Full Panel Editor, select Window > Project Pane.

This section shows the screens associated with these options as well as tables that contain 
details regarding each screen. 

Refer to Figure 3-12 and Table 3-6 for detailed descriptions of the options available on the 
Item Properties tab. You must have an item (budget or widget) selected before clicking this 
tab in order to view the options.

Figure 3-12. Item Properties Tab Pane
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 Table 3-6. Item Properties Tab Option Descriptions

Option Description

Basic View/edit the width, height, and location of the selected item (i.e., the selected button or 
widget).

Layer Choose what layer the selected item is on. Send the item Up or Down one layer, send to 
front (Top), or send to back (Bottom).

States Edit/add different states for the selected item (and the associated scripts and 
appearances during each state).

Border Set the border width/color/etc. for the selected item.

Box, Drop, and 
Text Shadow

Add/remove/adjust shadow settings for the selected item.

Touch Panel Key Assign the selected item to a physical button on the N-Touch Wall Controller.

Icon Choose an image to serve as an icon for the selected item.

Text Edit the text to be displayed on the selected item.
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Refer to Figure 3-13 and Table 3-7 for detailed descriptions of the options available on the 
Panel tab.

Figure 3-13. Panel Tab Pane

 Table 3-7. Panel Tab Option Descriptions

Option Description

Name View/edit the current panel’s name. Click the Set button to accept changes.

Width Set the width of the current panel (in pixels). Click the Set button to accept changes.

Height Set the height of the current panel (in pixels). Click the Set button to accept changes.

Default Panel Enable this checkbox to set the current panel as the device’s home screen.

Auto-Resize 
Panel to Device

Enable this checkbox to automatically size the current panel to fit the device’s screen 
when viewed as the active panel.

Show N-Touch Enable this checkbox to display the N8300 unit’s front panel on the Panel Builder editor 
screen.

Background 
Color

Edit the current panel’s background color.

Background 
Image

Select an image from your computer to be displayed as the current panel’s background.
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Refer to Figure 3-14 and Table 3-8 for detailed descriptions of the options available on the 
Project tab.

Figure 3-14. Project Tab Pane

 Table 3-8. Project Tab Option Descriptions

Option Description

Name View/edit the current project’s name.

Setup Script View/edit the setup script for the project.

Set project as 
N-Touch Panel

Enable this checkbox to set the current panel as the home page on the N-Touch Wall 
Controller screen. 

Snap Items to 
Panel

Enable this checkbox to force all buttons and widgets to remain on the panel background 
template of the editor (i.e., the white portion of the editor screen).

Pass Key Enter a pass code (any combination of numbers 1 through 8) if you would like a code to 
be required to access that panel on the N-Touch Wall Controller. If a Pass Key has been 
entered, a dialog appears on the N-Touch Wall Controller’s screen prompting the user to 
enter the key for access.

Panels Lists all items in the project. Click an item in the list to select it on the actual panel.
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Refer to Figure 3-15 and Table 3-9 for detailed descriptions of the options available on the 
Assets tab.

Figure 3-15. Assets Tab Pane

 Table 3-9. Assets Tab Option Descriptions

Option Description

Images View all images in the project.

Scripts Creates scripts that can be dragged and dropped onto multiple buttons at once.

Modules Use to control a specific type of device with the commands specific to that item. For 
example, .switch(#) is used to switch a unit’s stream.
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Tools Pane Option Descriptions
On the left side of the main screen, you will find options that allow you to access/create 
buttons, access widgets (such as sliders, text fields, etc.), as well as store panel templates for 
future use. If you do not see this pane displayed on the main page of the Full Panel Editor, 
select Window > Tools Pane.

To add a button or widget to your project, simply drag and drop it onto your module display as 
shown in Figure 3-16.

Figure 3-16. Adding a Button to the Display

This section shows the screens associated with these options as well as tables that contain 
details regarding each screen.

Refer to Figure 3-17 and Table 3-10 for detailed descriptions of the options available under 
the Buttons tab.

Figure 3-17. Buttons Tab Pane
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 Table 3-10. Buttons Tab Option Descriptions

Refer to Figure 3-18 and Table 3-11 for detailed descriptions of the options available on the 
Widgets tab.

Figure 3-18. Widget Tab Pane

Option Description

Default/User 
Buttons

Choose Default Buttons from the drop-down menu to access all of the system buttons. 
Select User Buttons to access buttons created previously to use as a template. Drag and 
drop to add a button you created to the User Button library. 

Down arrow allows you to download a file to import later. Up arrow opens a dialog box 
which allows you to browse to a file and import it into the User Button library. 
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 Table 3-11. Widgets Tab Option Descriptions

Option Description

Sliders Allows script to fill in value from 0 to 100 (or custom values between two numbers).

Text Adds text to the panel.

Image Adds an image to the panel. Drag and drop this icon to the panel and then double-click it 
to select an image file (supports .gif, .jpg, or .png file types).

Dialer widget Adds keypad to the panel (for data entry). 
Note: Not accessible from the N8301 N-Touch Wall Controller’s non-touch screen.

NVR Control 
widget

Adds play, stop, pause, etc. buttons for network video recorder (NVR) control.
Note: Not accessible from the N8301 N-Touch Wall Controller’s non-touch screen.

Encoder/Decoder 
Select

Click to add discovered units to a scrollable list (which will be available on the panel). Use 
the list to assign encoders and decoders to one another via the N-Touch Wall Controller.
Note: Not accessible from the N8301 N-Touch Wall Controller’s non-touch screen.
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Refer to Figure 3-19 and Table 3-12 for detailed descriptions of the options available on the 
Templates tab.

Figure 3-19. Templates Tab Options

 Table 3-12. Templates Tab Options

Now that you have familiarized yourself with the interface options, use the tutorials provided 
in the Help menus of the N-Touch Wizard and the Full Panel Editor to further explore the 
Panel Builder’s capabilities.

Option Description

Click the left arrow button to add the current panel to the template page. Click the right 
arrow button to apply the template to the current panel.

Deletes the currently selected template.

Click the down arrow to export the template library to your computer. Click the up arrow to 
browse to a (previously exported) button file and import it into the User Button library.
Note: When buttons are exported, they become .zip files.
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